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INTRODUCTION 

This guide explains what you need to know about using email on 
your Series 5, and provides instructions on how to set up your 
Series 5 in order to send and receive email messages. 

How TO USE THIS GUIDE 

I. Read the 'Before you start .. .' chapter to find out how you 

can use email on your Series 5, and the types of email 
'account' you can access. 

2. Read the 'Setting up your Series 5' chapter to find out how 
to set up email on your Series 5. 

3. After you've set up your Series 5, read the 'Using Email' 
chapter to find out how to use the Email program to send 
your first email message. 

WHERE TO FIND OUT MORE 

After you've set up email on your Series 5, you can find out more 
by consulting the: 

• Email on-line help, for detailed information about setting up 
and using the Email program. 

• Series Smx User Guide, for more information only on 
sending and receiving email messages. 

• Email manual (on the PsiWin CD ROM), for detailed 
information about setting up and using email, fax and SMS 
messages, and using the Email program. 

Displaying the on-line help. 

To display on-line help about Email on your Series 5, open the Email 
program and select Help on Email from the Tools menu. 
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BEFORE YOU START ••• 

How CAN I USE EMAIL ON MY SERIES s? 

You can use your Series 5 to send and receive email messages using 
either one, or both, of the following methods: 

I. Connecting by telephone line to a 'Remote' mailbox. 
This is when you make a 'live' connection to your email 
mailbox via a telephone line (without needing a PC). For 
example, you could access your personal mailbox by dialling 
your Internet Service Provider (ISP), or access your work 
mailbox by dialling your company's service provider or office 
mailbox. 

What to clo next ... 

If you want to access your work mailbox, you will first need to 
contact your network administrator to find out whether you can 
make a 'remote' (dial-up) connection to your mailbox. 
See 'What type of Emaii accounts can I use?' to continue. 

2. Connecting to a PC which can access your mailbox. This 
is when you connect directly to a PC which can access your 
mailbox. Using PsiWin's 'Email Synchronization', you can 
write emails off-line on your Series 5, and then connect to 
your PC to send and receive messages. 

How do I do this? 

To access your mailbox via a PC, you will first need to install PsiWin 
on the PC and set up 'Email Synchronization'. 
This guide does not include information on Email 
Synchronization. If you wish to use Email Synchronization see 
the PsiWin CD ROM. 

WHAT TYPE OF EMAIL ACCOUNTS CAN I USE? 

There are a number of different types of email account. See the list 
below to find out which types of account you can connect to using 
the Email program on your Series 5: 

• A personal 'dial-up' account. This could be a dial-up email 
account which you've signed-up for with an Internet Service 
Provider (ISP), e.g. Freeserve or Pipex Dial. 
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Which ISPs can I use? 

You can use most ISPs which use 'Internet standard' methods for 
connecting to your email account. However, some ISPs (such as 
America Online) use proprietary methods for connecting, and cannot 
be accessed by your Series 5 (i.e. you must use a PC). 
Move on to 'Setting up your Series 5' to continue. 
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• A 'remote' (e.g. office) email account. This could be an 
email account at your workplace, e.g. using Lotus cc:Mail or 
Microsoft Mail. 

How do I find out if I can use my account? 

You will need to find out from your network administrator whether 
you can access your email mailbox using this type of account. 
If you can, move on to 'Setting up your Series 5' to continue. 

• A Web based email account. This is an email account which 
you must connect to using a Web browser, e.g. HotMail or 
Yahoo! Mail. 

You can't connect to this type of account using the Email program. 

To use Web based email, you must first set up your Series 5 for 
Internet access. To do this, follow all the stages in the 'Setting up your 
Series 5' chapter, except 'Setting up the Email program'. You will need 
to use the Web program (supplied on the PsiWin CD ROM) to access 
your email provider's Web site. 

IF YOU DON'T HAVE AN EMAIL ACCOUNT 

You will require an email account before you can send and receive 
email messages on your Series 5. 

• To get a personal email account, you must 'sign-up' with an 
Internet Service Provider (ISP). ISPs usually provide an email 
account as part cif an Internet access package, which may also 
include Web access. 

• Most ISPs will provide software (e.g. a CD ROM) which will 
help you set up Internet access and the email account on a PC. 

Important: Some ISPs require that you connect to them using 
a PC in order to sign-up. If you can't do this, contact the ISP to 
find out if you can sign-up without using a PC. If you have 
Internet access, see "www.mobile.psion.com" for more 
details. 
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SETTING UP YOUR SERIES 5 

WHAT DO I NEED TO USE EMAIL? 

To send and receive email on your Series 5 you must have the 
following: 

I • An appropriate Email account. 
To access the Internet and use email, you will need an Internet 
'standard' email account. See the 'Before you start ... ' chapter 
for more details. 

2. AModem. 
You will need a modem to connect your Series 5 to the 
telephone network. You can use the following types of 
modem with your Series 5: 

• Standard external PC modems. 

• 'PC Card' modems. 

• Mobile phones with built-in modems. 
Note: if your mobile phone doesn't have a built-in modem, 
you will need to use it with a PC Card modem. 

3. A telephone connection. 
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If you are using a standard external modem or PC Card 
modem, you will need to connect your modem to a telephone 
socket. If you are using a mobile phone, your network 
operator will need to enable your SIM (Subscriber Identity 
Module) card so that you can make fax and data calls on your 
phone. If your phone has been enabled for fax and data calls, 
you should have two extra phone numbers. Contact your 
network operator if you are unsure whether your phone's 
SIM card is 'data-enabled'. 

Getting help. 

If you are having connection problems, you can find information about 
connecting using specific service providers, modems or mobile 
phones on our Web site at "www.mobi!e.psion.com". 
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WHAT INFORMATION DO I NEED? 

Before you can set up your Series 5, you will need to find out some 
information about your modem and your Internet email account by: 

+ Checking any documentation your ISP supplied about your 
Internet account, or contacting your network administrator at 
work. 

+ Checking your ISP's Web site for technical support. 

+ Contacting your ISP by email or phone for technical support. 

+ Checking the Psion Web site at "www.mobile.psion.com" for 
details of worldwide ISPs. 

Templates for popular service providers. 

The PsiWin CD ROM contains 'templates' for popular Internet Service 
Providers, including those in the UK, US and Germany. You can use 
these templates to help you quickly set up your email account. 

INFORMATION CHECKLIST 

The checklist overleaf shows what information you will need to set 
up your Series 5. Only your ISP or your network administrator can 
supply all the information required about your Internet email account. 

GLOSSARY OF TERMS 

Email 

ISP 

POP3/IMAP4 

SMTP 

TCP/IP 

DNS 

IP address 

Hostname 

An email (Electronic mail) is a text message which 
is sent over the Internet. 

Internet Service Providers are companies which 
provide you with access to the Internet. An ISP 
'account' normally includes the facility to send and 
receive email using a personal email address. 

Internet 'protocols' (standards) for receiving email. 

An Internet protocol used for sending email. 

An Internet protocol used by computers to 
communicate with each other. 

The Domain Name System is an address book 
which allows computers on the Internet to find 
each other by using 'IP addresses' and 'Hostnames'. 

A computer's unique Internet address, 
e.g. "194.129.243.153", used by computers to 
communicate with each other. 

A human readable version of an IP address, 
e.g. "www.psion.com" could be the same as the 
IP address" 194.129.243.153". 

@ Email Getting Started Guide 7 



00 I Information you need Where to find it Write it here 

The speed at which you should use your Your modem's documentation 
modem (called the baud rate) 

The phone number you need to dial to From your ISP/administrator 
connect to your ISP (often called a Point of 
Presence or POP) 

The username for your Internet account From your ISP/administrator, 
e.g. "jcrook" or "nd44" 

[I 
The password for your Internet account From your ISP/administrator, or you 

may have chosen this yourself 

Cl 
~ POP3 or IMAP4 server address From your ISP/administrator, :,· 

OQ (for incoming messages) e.g. "pop3.myisp.com" 
U) 

6! 
;:i SMTP server address From your ISP/administrator, ro 
a. 

(for outgoing messages) e.g. "smtp.myisp.com" Cl 
C: 
c.: 

Email address From your ISP/administrator, ro 

@ (your personal address) e.g. "myname@myisp.com" 



~ 
m 
3 
~ 
G) 

~ ~-

{ 
Cl.. 

G) 
C 
C: 
(1) 

'° 

Some service providers require additional information to 'log on' to their server. You may need the following information 
when using some service providers. 

Optional information 

IP address 
(if your ISP's server doesn't provide one 
automatically) 

DNS addresses 
(primary and secondary DNS addresses if 
your ISP's server doesn't provide them 
automatically) 

Mailbox login (if different from your 
Internet account username) 

Mailbox password (if different from your 
Internet account password) 

Where to find it 

From your ISP/administrator, 
e.g. "194.129.243.153" 

From your ISP/administrator, 
e.g. "123.255.78. 90" and 
"123.255. 78. 92" 

From your ISP/administrator 

From your ISP/administrator, or you 
may have chosen this yourself 

Write it here 



SETTING UP EMAIL ON YOUR SERIES 5 

If you have collected all the information in the checklist, you are 
now ready to set up your Series 5 to send and receive email. 

CONNECTING YOUR MODEM 

If you are using an external PC modem or PC Card modem: 

I. Connect your Series 5 to the modem using the Series S's 
serial cable. 

What do I need to do this? 

To connect your Series 5 serial cable to your modem you may require 
a Psion modem cable adapter. You can only use a Psion adapter, 
which can be obtained from your local distributor. 

2. Connect your modem to the telephone socket and switch on 
the modem. 

SETTING UP YOUR DIALLING LOCATION 

When you connect to the Internet, your Psion will need to dial 
your service provider's telephone. You can set up different dialling 
'locations' so that your Series 5 knows how to dial the number 
correctly, e.g. if you're dialling from the 'office' location, you might 
need to add a '9' before the number you want to dial. 

To set a dialling location: 

I. Move to the System screen and tap the Control Panel button 
on the Toolbar. 

2. Open the Dialling icon @' to display the dialling settings. 

3. Tap on the Current location line, and select the location 
you're dialling from: 

10 

Location Tone dialling Country 

i/Jl!li1©il,lll:'f:l.-J:lEl1l Home 
Set ~~.e __ l~-c~~i~~-that_t_h_e ma :Mobile 
+44 123 456789 

From the current location, the machine would dial the sample number like this 
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• Select 'Home' if you can dial without needing a prefix number. 

• Select 'Mobile' if you're using a mobile phone. 

• Select 'Office' if you need to use a prefix ('dial-out') number 
before dialling, e.g. '9'. 

If you don't want to use any of these pre-defined locations, 
you can add a new location by tapping the New button and 
entering the appropriate details. 

4. Tap on Edit and check that the dialling settings are correct for 
your location (this is not necessary for the 'Mobile' location), 
e.g. you may need to change the Area code. 

Location Dial out Chargecard Dial settings 

Home 
-----~~ 

Fixed line@ MobileO 

U_r,ited Kingdom. 
-0123 

5. Tap OK when you have finished setting up your dialling 
location. 
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SETTING UP YOUR MODEM 

To specify the type of modem you are using: 

I • Move to the System screen and tap the Control Panel button 
on the Toolbar. 

2. Open the Modems icon ~ to display the modem settings. 

3. Tap en the Current modem line, and select the modem 
you're using: 

Generic modem settings r···~ 
i set the type of modem you · 1 nfrared mobile phone 

e.g. for programs such as .Psi on Dacom Modem 

I New l Ed Psion Travel Modem 
Ctr!+N 

Select 'Generic modem settings' if your type of modem isn't 
shown. If the generic settings don't work for your modem, tap 
New to add a new entry for your modem. See the 
documentation supplied with your modem for the required 
settings. 

4. Tap OK when you have finished setting up your modem. 
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SETTING UP YOUR INTERNET SERVICE 

Once you have set up your dialling location and modem, you need 
to create a new ' Internet service' and enter your Internet account 
settings for your service provider. See 'What information do I 
need?' earlier for more details on the information required . 

To set up your Internet service: 

I • Move to the System screen and tap the Control Panel button 
on the Toolbar. 

2. Open the Internet icon 'Iii to display the Internet service 

settings. 

3. Tap New to create a new Internet service (account). 

4. On the Based upon line, select 'Standard settings', or if you 
have a 'template' file containing your ISP settings, select 
'Settings from file ' and choose the file . 

S. On the Service page, enter a name for your account and 
enter your service provider's dial-up number (or POP phone 
number) . 

New Internet service 

Service Account Addresses Login Advanced 

Name 

Connection type 

Use "smart" dialling 

My ISP 

Dial-up @ DirectO 

✓ 

Turn smart dialling off to dial numbers exactly as entered 

Standard dial-up number +44 123 456789 

Other dial-up numbers I Edtt I 
Ctrl+E 

~ 
etn+H 

I Save asl 
Ctrl+S 

I Cancel I 
[E] 

Ctrl+D 

6. On the Account page, remove the tick from Manual login 
and enter the username and password for your Internet 
account. 

New Internet service 

~ Account I Addresses II Login I Advanced I 
Manual login 

~ Turn 'Manual login' off to send account detalls automaticalty on connection 
etn+H 

l•B4ie6111H your-username I Save asl 
Password *"'****** Ctr1+S 

Confirm password **** "' *** I Canoe! ( 
Note : Username and password are case sensitive 

I Done I 
etn+o 
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7. If your service provider requires you to specify IP and DNS 
addresses, you can set these on the Addresses page. Before 
you can enter IP and DNS addresses, you must first remove 
the ticks from the Get IP address from Server and Get 
DNS address from server boxes. 

Leave 'Get address ... ' lines ticked unless your service provider has told you to specify 
the IP and DNS addresses yourself 

Get IP address from server 

IP address 
Get DNS address from server [J 
Primary DNS address ~11~2.~3~4.~5~6.~7~8-~ 

Secondary DNS address i 123.45.67.89 

8. When you have finished entering the settings, tap Done to 
return to the 'Internet service settings' dialog. The new 
service you've created will be shown on the Current 
Internet service line. Tap OK to return to the Control Panel. 

What if I need to use a 'login script'? 

Some Internet Service Providers require that you use a login script 
when you connect, e.g. to send details such as your usemame and 
password. You can type in a login script on the Login page of your 
Internet service settings. See the Email manual on the PsiWin CD 
ROM for more information on writing login scripts. 

SETTING UP THE EMAIL PROGRAM 

Once you have set up your Internet service, you can set up your 
email account in the Email program. 

To create a new account in Email: 

I. Tap on the Email program icon ®· 
2. Select Email from the Add new account command on the 

Tools menu. 

3. On the Account page: 

• Enter a name for your account (this can be anything you 
want). 

• Enter your name as you want it to appear on all emails you 
send on the Your name line. 

• Enter your email address, e.g. "my.name@myisp.com". 

• If the Mailbox type line is displayed, choose the mailbox 
type, e.g. 'POP3' or 'IMAP4'. 
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Settings. for "My mail" account 

Outgoing Incoming 

Account name 

Your name 

Email address 

Mymaff· 
1v1ynariie 

Enter the email address your Internet service provider gave you, e.g.bob@isp.com 

Mailbox type 

Set as default account 

POP3 

,[_ 

4. On the Outgoing page: 

+ Enter your outgoing mail (SMTP) server address, 
e.g. "smtp.myisp.com". 

Seft,ngs for"My maH" account __ 

Account I Outgoing I Incoming I 
~---=--=-J~-=--=--=--=-~--:.-:_-:_-:_-:_-:_-:_-:_-:_-:_-:_-:_-:_-:_-:_-:_-:_-:_-:_-:_-:_-:_~---, 

l=GiFUl@~ll=il14ri4i smtp.myisp.com 
Enter the emal! server for your Internet seMce provider, e.g. mail.isp.com 

Auto send on opening IAdvancedJ [,:; 
Ctrl+A 

I Cancel I 

5. On the Incoming page: 

+ Enter your incoming mail (POP3 or IMAP4) server address, 
e.g. "pop3.myisp.com". 

+ Enter your mailbox login (or username) and mailbox password 
(these may be the same as your Internet username and 
password). 

Settings for "M¥__1l18:il" account 

Account Outgoing Incoming 
~-------------~ 

Enter the POP3 server for your network provider, e.g. mail.isp.com 

Mailbox login ~your-username __ -~~~~~~~~~-
Enter the mailbox login your network provider gave you 

Mailbox password 

Confirm password 
Passwords are case sensitive 

6. Tap OK when you've finished entering your email account 
settings. 
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USING EMAIL 

This chapter briefly introduces how to create a new email message 
and how to send and receive email. For more information on using 
the Email program, see 'Where to find out more' at the beginning 
of this guide. 

FINDING YOUR WAY AROUND .•• 

When you first open Email, you will see the 'Folders' view which 
displays your mailboxes, folders and messages. The 'Local' folders 
(on the left) are stored on your Series 5, so you can create and 
view messages in these folders when you aren't connected. 

When you have set up an email account, ·a 'Remote' mailbox ',, 

will be displayed (with the name you gave your account) below the 
Local folders. When you connect, you can transfer (or 'download') 
incoming messages from your Remote mailbox to the Local folders 
on your Series 5. 

Connected to Internet 

To/From Subject Date " Size 
!;J/l' Local b.peter@broo ... Fwd: specia ... 29/03/1999 27k 

[

,$ll, lnbox 0 henry.court@... Re: More is ... 29/03/1999 

~-MflH•M 0.·•.·· jane.philips@c ... Lunch on fri... 29/03/1999 
~ Draft 0 dennis-b@gre ... Spare parts 29/03/1999 

@ Sent 0 j. faulkner@flip ... Conference ... 29/03/1999 

(r,; Personal 
~ Work mail 

The following Local folders are displayed: 

~ lnbox: contains your messages when you have transferred 

them from your Remote mailbox. 

~ Outbox: contains outgoing messages which you can send 

when you next connect. 

~ Draft: contains unfinished messages you are still writing. 

I) Sent: contains copies of messages you have sent. 
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You can use Local folders in the same way as you use folders in the 
System screen, e.g.: 

• You can create a new folder by tapping the New button on 
the Toolbar and selecting Folder, or by using the command on 
the File menu. 

• You can move and copy messages between folders by using 
the commands on the Edit menu. 

WRITING AN EMAIL 

You can write a new email message when you aren't connected, 
then save it to a Local folder on your Series 5 so you can send it 
when you next connect. You do not need to be connected to the 
Internet or your email account (Remote mailbox) to prepare, read 
and respond to messages; the only time you need to connect is 
when you wish to send or receive messages. 

To create a new email: 

I. Tap the New button on the Toolbar and select Email. Email 
displays the 'message editor' in which you can write your 
message. 

01:36:48 pm 15/04/1999 
To: 

CC: 

8CC: 

Attachments: 

Subject: 

Hi there, 

my.friend@any.com 

Holiday booking 

Priority: :Normal 

I've confirmed the holiday booking with the travel agent for 
► for the 31st June. 

2. Enter the recipient's email address(es) on the To line, 
e.g. "my.friend@any.com". 

3. Enter the title of your message on the Subject line. 

4. Enter your message text in the area below the subject line. 

5. When you have finished writing the email: 

• If you want to send the message when you next connect, tap 
on Save to outbox on the Toolbar. 

• If you want to edit the message before sending, tap on Save 
as draft on the Toolbar to place the message in your Draft 
folder. 
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SENDING EMAIL 

When you're ready to connect and send your email, make sure all 
the messages you want to send are in the Outbox folder. 

To send email: 

I. Move to the Outbox folder to view the message(s) you want 
to send. 

2. Tap the Send button on the Toolbar, then either select Email 
to send all the Email messages from the Outbox, or Selected 
to send only the messages you've highlighted. 

• If you are not connected to the Internet, you will be shown 
details of the connection which your Series 5 will use. Make 
sure these settings are correct before proceeding. Once 
connected, your message(s) will be sent. 

Email will send the messages from your Local Outbox folder. 
Copies of emails that have been sent are placed in the Sent folder; 
whilst messages which couldn't be sent are left in the Outbox and 
displayed in italics. 

How do I send Outbox messages automatically when I connect? 

You can send messages in the Outbox automatically when you 
connect. To do this, select the name of your account from the 
Account settings commands on the Tools menu. Then move to the 
Outgoing page and tick the Auto send on opening box. 

~Local 

i
~ lnboK 

~1outbOK 
~ Draft 
@.Sent 

1}I Personal 
~Work mail 

18 

~ mike.jackson@ ... Holiday 2 

~ j.faulkner@flip ... Re: Confer ... 

~ jane.philips@c ... Re: Lunch .. . 

~ g. forrester@b ... Fwd: specia ... 29/03/1999 
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RECEIVING EMAIL 

You must connect to your Internet Service Provider when you wish 
to receive messages using your email account. 

To receive email: 

I. Tap Open mailbox on the Toolbar. 

• If you are not connected to the Internet, you will be shown 
details of the connection which your Series 5 will use. Make 
sure these details are correct before proceeding. 

2. When your Series 5 is connecting, Email will display progress 
messages at the top of the screen. When you have connected 
to your mailbox, you can see all the messages it contains by 

tapping on the mailbox icon ~- The title and details of each 
message are displayed, with new messages displayed in bold. 

3. To read the messages in your mailbox, you must transfer (or 
'download') them to the Local lnbox on your Series 5. 
Highlight the messages you want to read then: 

• To copy the message to your Local lnbox, tap Copy (lnbox) 
on the Toolbar, or select the command from the Transfer 
menu. 

• To move the message to your Local lnbox, select Move to 
inbox from the Transfer menu. 
Note: If you move messages from your Remote mailbox, the 
only copies of these messages will be in the Local lnbox on 
your Series 5. 

4. When you have finished sending and receiving emails, tap 
Close mailbox on the Toolbar. To disconnect from the 
Internet, select Disconnect from Internet on the File menu. 

My Remote lnbox is empty. 
If this is the first time you have used email with your Internet Service 
Provider, you may not have any incoming email messages waiting to 
be received. If you are expecting an email message. please note that 
messages can take anything from 5 minutes to 48 hours to be 
delivered. 
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